Section 1  About this User Guide

The Interconnection Request Tracking Tool (IRTT) User Guide is grouped into independent sections arranged by topic and user role. This guide details the system supporting the submission process of Interconnection Requests (IRs) for large and small generators. This guide is not intended to be read from beginning to end, but rather to be used as a tool and a reference when the user needs a refresher or understand a new function of the tool.

You may:

- Select a topic from the “How To” list on page 7.
- Start with an Overview of the Interconnection Request process on page 7.
- Select IRTT Roles from the Table of Contents or from the list on page 226.

CAUTION

- Though we strive to maintain this User Guide as current as possible, the screen shots in this guide may not fully reflect the current production environment.
- Do not rely only on this user guide for information or requirements as the Market Rule and Manuals serve that function.
- Please consult:
    - Section I – General Terms and Conditions
    - Section I.2.2 – Definitions
    - Section II – Open Access Transmission Tariff
    - Section II. Schedule 22 – Standard Large Generator Interconnection Procedures
    - Section II. Schedule 23 – Standard Small Generator Interconnection Procedures
    - Section II. Schedule 25 – Elective Transmission Upgrade Interconnection Procedures
  - The relevant supporting documentation for new or modified interconnections on the ISO New England website at: http://www.iso-ne.com/participate/applications-status-changes/new-modified-interconnections
## Section 2 Change Summary

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 1.0</td>
<td>May 31, 2013</td>
<td>Initial release</td>
</tr>
<tr>
<td>Version 2.0</td>
<td>December 23, 2014</td>
<td>Updated for recently FERC approved Schedule 23 changes, and additional system enhancements</td>
</tr>
<tr>
<td>Version 3.0</td>
<td>TBD, 2017</td>
<td>Updated to reflect new IRTT implementation / user interfaces</td>
</tr>
</tbody>
</table>
Section 3 Contents

Section 1 About this User Guide ........................................................................................................... ii
Section 2 Change Summary .................................................................................................................... iii
Section 3 Contents .................................................................................................................................. iv
Section 4 Overview of IRTT .................................................................................................................. 6
Section 5 How To ...................................................................................................................................... 7
  5.1 Get Started ....................................................................................................................................... 7
    5.1.1 Overview of the Interconnection Request process ................................................................. 7
    5.1.2 Accessing IRTT ......................................................................................................................... 9
    5.1.3 Maintaining IRTT Access .......................................................................................................... 36
    5.1.4 Managing Level of Access for a User Account ........................................................................ 72
    5.1.5 Managing Access to Interconnection Requests ..................................................................... 78
  5.2 IRTT User Interface Summary ....................................................................................................... 86
    5.2.1 IRTT Home Menu ...................................................................................................................... 86
    5.2.2 Manage Requests Menu ........................................................................................................... 92
    5.2.3 Reports Menu .......................................................................................................................... 92
    5.2.4 Form Templates Menu ............................................................................................................. 93
    5.2.5 Settings Menu .......................................................................................................................... 94
  5.3 Managing Interconnection Requests ............................................................................................... 94
    5.3.1 Managing Interconnection Requests Overview ..................................................................... 94
    5.3.2 Submitting an Interconnection Request ................................................................................. 95
    5.3.3 Viewing an Interconnection Request ...................................................................................... 153
    5.3.4 Viewing the IR Dashboard ...................................................................................................... 218
    5.3.5 Viewing the Public Queue ...................................................................................................... 221
  5.4 Communications ............................................................................................................................. 223

Section 6 IRTT Roles ............................................................................................................................... 226
  6.1 IRTT Customer Admin .................................................................................................................... 226
  6.2 IRTT IR Manager ............................................................................................................................ 226
  6.3 IRTT Viewer .................................................................................................................................... 227

Section 7 Customer Support .................................................................................................................... 229
  7.1 By Internet ....................................................................................................................................... 229
  7.2 By Telephone ................................................................................................................................... 229
  7.3 By Email ......................................................................................................................................... 230
  7.4 Ask ISO .......................................................................................................................................... 230
Section 8 Links ......................................................................................................................... 231
  8.1 ISO New England Home Page ......................................................................................... 231
  8.2 ISO New England Training Page .................................................................................. 231
  8.3 ISO New England FAQ Page .......................................................................................... 231
  8.4 SMD Site for ISO Applications ..................................................................................... 231
  8.5 SMD Site for ISO Sandbox Applications ....................................................................... 231
  8.6 ISO New England Glossary and Acronyms ................................................................. 231
Section 9 Reference Tables .................................................................................................... 232
  9.1 IRTT Roles and Permissions ......................................................................................... 232
  9.2 IRTT System Requirements .......................................................................................... 233
Section 4 Overview of IRTT

The Interconnection Request Tracking Tool (IRTT) is ISO New England’s tracking tool for Large Generator Interconnection Requests, Small Generator Interconnection Requests, and Elective Transmission upgrades (ETU) Interconnection Requests. IRTT is used for interconnection Customer submittal and ISO review and approval process associated with Interconnection Requests.

Customers are encouraged to review the relevant governing language in Section II of the Tariff prior to using IRTT to submit Interconnection Requests.

- Schedule 22 – Standard Large Generator Interconnection Procedures
- Schedule 23 – Standard Small Generator Interconnection Procedures
- Schedule 25 – Elective Transmission Upgrade Interconnection Procedures

IRTT is available to customers as an internet-based tool for:

- Creating user accounts (see “Creating an IRTT Customer Admin Account (first IRTT account)” on page 16)
- Managing user account roles (see “Managing Level of Access for a User Account” on page 72)
- Granting access to an Interconnection Request (see "Managing Access to Interconnection Requests” on page 78)
- Submitting Interconnection Requests (see “Submitting a new Large Generator Request” on page 95, “Submitting a new Small Generator Request” on page 115, or “Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request” on page 130)
- Viewing and curing existing interconnection requests (see “Viewing and Curing Large Generator Request” on page 154, “Viewing and Curing a Small Generator Request” on page 164, or “Viewing and Curing an Elective Transmission Upgrade (ETU) Interconnection Request” on page 179)
Section 5  How To

5.1 Get Started

This section covers the following topics:

5.1.1 – Overview of the Interconnection Request process (page 7)
5.1.2 – Accessing IRTT (page 9)
5.1.3 – Maintaining IRTT Access (page 36)
5.1.4 – Managing Level of Access for a User Account (page 72)
5.1.5 – Managing Access to Interconnection Requests (page 78)

5.1.1 Overview of the Interconnection Request process

This section covers the following topics:

5.1.1.1 – Application Security and Account Management (page 8)
5.1.1.2 – ISO New England Glossary and Acronyms (page 8)
This document describes the tool employed by ISO New England to track Large and Small Generator Interconnection Requests, and Elective Transmission Upgrade Interconnection Requests. The procedures for Large and Small Generator interconnection can be found in Schedules 22 and 23, respectively, of the Open Access Transmission Tariff (OATT), Section II of the Transmission, Markets and Services Tariff (Tariff). The procedures for Elective Transmission Upgrade interconnection can be found in Schedules 25 of the Open Access Transmission Tariff, Section II of the Transmission, Markets and Services Tariff (Tariff).

Customers are encouraged to review the relevant governing language in Section II of the Tariff prior to using IRTT to submit Interconnection Requests.

- **Schedule 22 – Standard Large Generator Interconnection Procedures**
- **Schedule 23 – Standard Small Generator Interconnection Procedures**
- **Schedule 25 – Elective Transmission Upgrade Interconnection Procedures**

5.1.1.1 *Application Security and Account Management*

Access to IRTT is managed through the tool itself and is described below in the section titled “Accessing IRTT” on page 9. Access to view Interconnection Requests must be specifically assigned by user roles. See the section titled “Managing Access to Interconnection Requests” on page 78 for more details.

The person at your company with the IRTT Customer Admin role is responsible for assigning IRTT user access roles per your company’s internal procedures and controls. All users must submit a Critical Energy Infrastructure Information (CEII) Non-Disclosure Agreement form in order for their account to be verified. In addition to being able to download the form from the Pre Account Registration page in IRTT, the CEII Request Form can also be found on the ISO New England website under Participate > Support > Library of Customer Support Forms. https://www.iso-ne.com/static-assets/documents/2015/08/external_ceii_request.pdf

Customers may provisionally submit Interconnection Requests to IRTT before their account status has been verified.

Each user is able to change their password. This is done via the Settings->Manage Accounts menu. For instructions on this, please refer to “Changing an IRTT Password” on page 49.

5.1.1.2 *ISO New England Glossary and Acronyms*

For a full list of ISO New England terms and acronyms, see the Glossary and Acronyms listing on ISO New England’s website at:

[https://www.iso-ne.com/participate/support/glossary-acronyms](https://www.iso-ne.com/participate/support/glossary-acronyms)
5.1.2 Accessing IRTT

This section covers the following topics:

5.1.2.1 – Summary of IRTT Access (page 9)
5.1.2.2 – Accessing IRTT via the ISO-NE Application Portal (page 11)
5.1.2.3 – Singing Into IRTT (page 12)
5.1.2.4 – Singing Out of IRTT (page 15)
5.1.2.5 – Creating an IRTT Customer Admin Account (first IRTT account) (page 16)
5.1.2.6 – Creating an Additional IRTT Account (Admin setup) (page 23)
5.1.2.7 – Confirming an Additional IRTT Account (Non-Admin setup) (page 29)
5.1.2.8 – Creating User Accounts for existing Users of other Related Companies (page 31)

5.1.2.1 Summary of IRTT Access

➢ I do not have an IRTT role. How do I access IRTT?

Contact your company’s IRTT Customer Admin to request access to IRTT. For instructions to register additional users under an existing company, see the section titled “Creating an Additional IRTT Account (Admin setup)” on page 23.

To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.

➢ I do not have an IRTT role and my company has not registered in IRTT. How do I access IRTT?

Please register your company and establish the first user account. See the section titled “Creating an IRTT Customer Admin Account (first IRTT account)” on page 16 for instructions on registering the account.

➢ IRTT Access Roles

- Viewer
  - View Interconnection Requests as assigned
  - Edit user contact information (for self only)
  - View Public queue
- IR Manager
  - Perform all Viewer functions
  - Create new Interconnection Request drafts
  - Assign user to view / edit Interconnection Requests
  - Submit completed draft Interconnection requests if assigned
- Edit / delete Interconnection Request drafts if assigned
- Cure Interconnection Requests (create a new Interconnection Request draft revision)

- Customer Admin
  - Perform all Viewer and IR Manager functions
  - Modify company details
  - Add new users and customer representatives
  - Assign user permissions
  - Edit contact information for all users in company

<table>
<thead>
<tr>
<th>IRTT Access Roles</th>
<th>Customer Admin</th>
<th>IR Manager</th>
<th>Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new draft Interconnection Requests</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Assign users to view/edit Interconnection Requests</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Submit completed draft Interconnection Requests (if assigned)</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Edit / delete draft Interconnection Requests (if assigned)</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Cure Interconnection Requests (create new Interconnection Request version)</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>View Interconnection Requests (if assigned)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify company details</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add new employees</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add new customer representatives</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set permissions for users in company</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit user contact information (all users in company)</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit user contact information (self only)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View public queue</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
5.1.2.2 Accessing IRTT via the ISO-NE Application Portal

All users external to ISO-NE will be able to access IRTT through the ISO-NE Application Portal. Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer


Step #2: Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

IMPORTANT! Please see the IRTT System Requirements on page 233 if you have any technical issues.
5.1.2.3 **Signing Into IRTT**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4:  Once there are no submission issues, the IRTT Home screen will be displayed.

**IMPORTANT!**

- If you wish to change your password, click “Reset Password” (unlocked icon) from the Settings-&gt;Manage Accounts-&gt;Account Details screen for your account. Once you have reset your password, the system will send you an e-mail at the e-mail address associated with your account containing a link to the IRTT Reset Password screen. Please see “Changing an IRTT Password” on page 49 for more information.
- Passwords must be reset every 90 days. If your last sign in is beyond 90 days, you will be required to change your password.
- Your IRTT session will be automatically signed out due to inactivity in order to prevent unwarranted access. IRTT will notify you that your account has been identified as being inactive. If you do not refresh the session, it will...
5.1.2.4 **Signing Out of IRTT**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**Step #1:** Select “Sign Out” (right arrow icon) in the top-right corner from any screen within IRTT.

**Step #2:** The IRTT Sign In screen will be displayed and you have been signed out of IRTT.
5.1.2.5 Creating an IRTT Customer Admin Account (first IRTT account)


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Select “CREATE ACCOUNT” at the top right of the screen or “Request an Account” below the IRTT title.

Step #3: The IRTT Pre Account Registration screen will be displayed.
Step #4: Indicate whether you’ve submitted the CEII Request Form, NDA form (included with CEII Request form), and an ISO NE Customer ID form and then click “Continue”. Please Note: All required data elements are noted with an asterisk (“*”).

- The CEII Request Form can be found on the ISO New England website under Participate > Support > Library of Customer Support Forms or by clicking the “CEII Request Form” link in the IRTT – CEII Request Form section.
- The Generator Interconnection Studies Billing form is referred to as the “ISO NE Customer ID Request Form” in IRTT and can also be found under Participate > Support > Library of Customer Support Forms or by clicking the “ISO NE Customer ID Request Form” link in the IRTT – ISO NE Customer ID Form section.

NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header, “SIGN IN” at the top right of the screen, or “Back” at the bottom of the screen. No submitted information will be validated or saved.
IMPORTANT!

- You must submit the CEII Request Form prior to or in conjunction with registering a user account. The online account registration form provides a link to the CEII Request Form.
- You must submit the Generator Interconnection Studies Billing form prior to or in conjunction with registering a company account. The online account registration form provides a link to the ISO NE Customer ID Form (also referred to as the Generator Interconnection Studies Billing form).

Step #5: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #6: Once there are no submission issues, the IRTT Account Registration screen will be displayed.
Step #7: Provide your Registration, Company Details, and Billing Information on the IRTT Account Registration screen. All required data elements are noted with an asterisk (*).

Be sure to review the IRTT Terms and Conditions using the provided link and to click "I agree with the Terms and Conditions".

The IRTT Password must be contain more than six (6+) characters, at least one number, at least one upper and lower case letter, and at least one special character.

IRTT requires you enter the randomly generated security code exactly as it is presented. Enter the presented security code in the data element provided just below the security code. If you need a different security code, or need to hear it spoken, click the refresh icon or the speaker icon presented just to the right of the security code.

Select the “Register” button to continue.

NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header, “SIGN IN” at the top right of the screen, or “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #8: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #9: Once there are no submission issues, you will be redirected to the IRTT Post Registration screen. At this point you may close your browser or click “Home” to return to the IRTT Sign In screen.

Step #10: You will receive an e-mail at the e-mail address provided which contains a link to confirm the account request and e-mail address. Click on the “here” link.

Please contact ISO-NE @ IRTT@iso-ne.com if you do not receive the e-mail.
Step #1: Once the account request and e-mail address is confirmed, IRTT will display the Account Confirmation screen. You can now sign in to the IRTT by clicking on “SIGN IN” in the top-right corner of the screen.

See “Signing Into IRTT” on page 12 for more information.

Step #12: Once your account is verified, as the IRTT Customer Admin you will be able to add additional employees and assign the appropriate roles for your company. You will also be able to add company representative users who can help you manage specific Interconnection Requests or aspects of the process.

The account validation process generally takes three to five business days. However, you can start entering the details of an Interconnection Request immediately.
Only the first account for a company is established this way.
Subsequent user accounts are added by those users with the IRTT Customer Admin role (initially, this will be the first user registering for your company).
To learn if an account has already been established for your company, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.
If you register a second account in this way, a new company is established thus separating your activities, as if it were two individual companies.

5.1.2.6 Creating an Additional IRTT Account (Admin setup)

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled "Managing Level of Access for a User Account" on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.

CAUTION

- Once a company's first IRTT Customer Admin user account is verified, that user is able to enter additional users. Unverified user accounts are restricted to modifying only the company details and submitting Interconnection Requests.
- Please wait until your first user account is verified prior to adding users to your company's account. Registering user accounts without first initiating it through the Account Management feature of IRTT will result in multiple
customer accounts, thereby separating the Interconnection Requests into multiple customer accounts. This will ultimately result in delays and you will be asked to resubmit requests under a single account.

Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to add a new account to.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Create user” (pencil icon) in the Company Users header.
Step #7: The IRTT New Account screen will be displayed.

Provide your New Account Information on the IRTT New Account screen. All required data elements are noted with an asterisk ("*").

The Company data element is pre-populated with the associated company and cannot be modified.

Indicate whether the user has submitted the CEII Request Form, NDA form (included with CEII Request form), and an ISO NE Customer ID form and then click "Create".

NOTES:

- You can return to the IRTT Account Management screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

- You can return to the IRTT Home screen by clicking the ISO-New England IRTT System title in the screen's header. No submitted information will be validated or saved.
Step #8: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #9: Once there are no submission issues, the IRTT Company Details screen will be displayed. At this point the new account has been created and requires confirmation by the new user.
Step #10: Please see “Confirming an Additional IRTT Account (Non-Admin setup)” on page 29 to continue the registration process. The additional user must validate the submitted e-mail address and then submit a password for the account to complete the process.

5.1.2.7 Confirming an Additional IRTT Account (Non-Admin setup)

Step #1: Once your IRTT Customer Admin has created your account, you will receive an e-mail at the e-mail address provided which contains a link to confirm the account request and to create a password. Click on the “here” link.

Please contact ISO-NE @ IRTT@iso-ne.com if you do not receive the e-mail.
Step #2: The IRTT Password Create screen will be displayed. The new user should enter a password for their new account and click “Create”.

The IRTT Password must contain more than six (6+) characters, at least one number, at least one upper and lower case letter, and at least one special character.

NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen's header, “SIGN IN” at the top right of the screen, or “Back” at the bottom of the screen. No submitted information will be validated or saved.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Password Reset Successful screen will be displayed. You can now sign in to the IRTT by clicking on “SIGN IN” in the top-right corner of the screen.

See “Signing Into IRTT” on page 12 for more information.
5.1.2.8 Creating User Accounts for existing Users of other Related Companies

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.
CAUTION

- The two companies must already be related before users in the subsidiary can add users from the parent company.
- Please contact ISO-NE at IRTT@iso-ne.com for more information.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click "Sign In" to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to add a new account to.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Add user” (addition sign icon) in the Company Users header.
Step #7: The IRTT Add Existing User screen will be displayed. You can click the desired existing user(s) to be added to the subsidiary company by clicking the checkboxes on the left-side of the screen “on”.

Click on “Add” at the bottom of the screen to add the selected user(s) to the current company.

NOTE: You can return to the IRTT Company Details screen by “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #8: The IRTT Company Details screen will be presented and the new users will be displayed in the Company Users section.

5.1.3 Maintaining IRTT Access

This section covers the following topics:

- 5.1.3.1 – Viewing a User Account’s Details (page 36)
- 5.1.3.2 – Modifying a User Account’s Details (page 40)
- 5.1.3.3 – Resetting a Forgotten IRTT Password (page 45)
- 5.1.3.4 – Changing an IRTT Password (page 49)
- 5.1.3.5 – Removing a User Account (page 53)
- 5.1.3.6 – Creating a Subsidiary Company (page 60)
- 5.1.3.7 – Adding an existing Subsidiary Company (page 63)
- 5.1.3.8 – Removing a Subsidiary Company (page 70)

5.1.3.1 Viewing a User Account’s Details

Role this applies to:
IRTT Customer Admin
IRTT IR Manager
IRTT Viewer


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Accounts from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Account Management screen will be displayed. Click on “View Details” (pencil icon) at the right end of the record for the account you wish to view.

Step #6: The IRTT Account Details screen will be displayed for that account.

NOTE: You can return to the IRTT Account Management screen by clicking on “Back” at the bottom of the screen.
5.1.3.2 Modifying a User Account’s Details

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

NOTE: Only the account’s owner can modify the details of the account.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Accounts from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Account Management screen will be displayed. Click on "View Details" (pencil icon) at the right end of the record for the account you wish to view.

Step #6: The IRTT Account Details screen will be displayed for that account. Click on "Edit" at the bottom of the screen.
NOTE: You can return to the IRTT Account Management screen by clicking on “Back” at the bottom of the screen.

Step #7: The IRTT Edit Account screen will be displayed.

Update your Account Details on the IRTT Edit Account screen. All required data elements are noted with an asterisk (“*”).

The E-mail address data element is pre-populated with the associated e-mail address and cannot be modified.

The CEII Request Form, NDA form, and the ISO NE Customer ID form data elements are pre-populated with the current values and cannot be modified.

Click on “Submit” at the bottom of the screen to save your changes.

NOTE: You can return to the IRTT Account Details screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #8: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #9: Once there are no submission issues, the IRTT Account Management screen is displayed and your account changes were saved.
5.1.3.3 **Resetting a Forgotten IRTT Password**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Select “Forgot Password?” in the Sign In section.

Step #3: IRTT will present the Reset password section in place of the Sign In section on the IRTT Sign In screen.
Step #4: Submit your sign in credential (the email address you registered with). Select “Send email” to continue the process.

Step #5: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #6: Once there are no submission issues, you will be redirected to the IRTT Password Reset confirmation screen. At this point you may return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header, “SIGN IN” at the top right of the screen, or “Home” at the bottom of the screen.
Step #7: You will receive an e-mail at the e-mail address associated with the account which contains a link to reset the password. Click on the “here” link.

Please contact ISO-NE @ IRRT@iso-ne.com if you do not receive the e-mail.

Step #8: The user should enter a new password for their account and click “Reset”.

The IRTT Password must contain more than six (6+) characters, at least one number, at least one upper and lower case letter, and at least one special character.

NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header, “SIGN IN” at the top right of the screen, or “Back” at the bottom of the screen. No submitted information will be validated or saved.
Step #9: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #10: Once there are no submission issues, the IRTT Password Reset Successful screen will be displayed. You can now sign in to the IRTT by clicking on “SIGN IN” in the top-right corner of the screen.

See “Signing Into IRTT” on page 12 for more information.

5.1.3.4 Changing an IRTT Password

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Accounts from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Account Management screen will be displayed. Click on "View Details" (pencil icon) at the right end of the record for the account you wish to view.

Step #6: The IRTT Account Details screen will be displayed for that account. Click on the "Reset Password" (gold lock icon) in the header next to your name.
NOTE: You can return to the IRTT Account Management screen by clicking “Back” at the bottom of the screen.

Step #7: IRTT will display a “Reset User Password” confirmation message. Click on “Yes” to reset your password.

NOTE: You can return to the IRTT Account Details screen without resetting the password by clicking “No”.

Step #8: You will receive an e-mail at the e-mail address associated with the account which contains a link to reset the password. Click on the “here” link.

Please contact ISO-NE @ IRTT@iso-ne.com if you do not receive the e-mail.

Step #9: The user should enter a new password for their account and click “Reset”.

The IRTT Password must contain more than six (6+) characters, at least one number, at least one upper and lower case letter, and at least one special character.
NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header, “SIGN IN” at the top right of the screen, or “Back” at the bottom of the screen. No submitted information will be validated or saved.

Step #10: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #11: Once there are no submission issues, the IRTT Password Reset Successful screen will be displayed. You can now sign in to the IRTT using the new password by clicking on “SIGN IN” in the top-right corner of the screen.

See “Signing Into IRTT” on page 12 for more information.

5.1.3.5 Removing a User Account

Role this applies to:
NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to remove an account from.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Remove user” (red trash can icon) at the right end of the record for the user you wish to remove.
Step #7: IRTT will display a “Remove user from company” confirmation message. Click on “Yes” to remove the selected user.

NOTE: You can return to the IRTT Company Details screen without removing the selected user by clicking “No”.

Step #8: The IRTT Company Details screen will be displayed and the user will have been removed.
5.1.3.6 Creating a Subsidiary Company

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to add a subsidiary company to.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Create company” (pencil icon) in the Related Companies header.
Step #7: The Create Company screen will be displayed. Submit the new company’s information and click on “Create”. All required data elements are noted with an asterisk (“*”).
Step #8: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #9: Once there are no submission issues, the IRTT Company Management screen will be displayed and the new company will be presented.

NOTE: You can return to the IRTT Company Management screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
5.1.3.7 Adding an existing Subsidiary Company

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to add a subsidiary company to.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Add company” (plus sign icon) in the Related Companies header.
Step #7: The IRTT Add Related Company screen will be displayed. Select which company you want to relate to the selected company and click “Add”.

NOTE: You can return to the IRTT Company Details screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #8: The IRTT Company Details screen will be displayed for that company with the related company presented.
5.1.3.8 Removing a Subsidiary Company

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.
Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3:  IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4:  Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->>Manage Company from the IRTT menu on the left side of the IRTT Home screen.

Step #5:  The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to remove a related company from.
Step #6: The IRTT Company Details screen will be displayed for that company. Click on "Remove company" (red trash can icon) at the right end of the record for the related company you wish to remove.

Step #7: IRTT will display a "Remove related company" confirmation. Click on "Yes" to remove the related company.

NOTE: You can return to the IRTT Company Details screen without removing the selected user by clicking "No".

Step #8: The IRTT Company Details screen will be displayed and the related company will no longer be presented.
5.1.4 Managing Level of Access for a User Account

This section covers the following topics:

5.1.4.1 – Modifying the Role of a User Account (page 72)

5.1.4.1 Modifying the Role of a User Account

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Settings->Manage Company from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Company Management screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the company you wish to modify the user role(s) for.

Step #6: The IRTT Company Details screen will be displayed for that company. Click on “Edit security” (gold lock icon) at the right end of the record for the user you want to modify the user role(s) for.
Step #7: The IRTT Edit User Security screen will be displayed. Modify the Status of each Role to grant the user the desired level of access.

See “IRTT Roles” on page 226 for definitions of each IRTT Role.

Click on “Save” to continue.

NOTE: You can return to the IRTT Company Details screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #8: The IRTT Company Details screen will be displayed and your changes to the user role(s) for the given user have been saved.
5.1.5 Managing Access to Interconnection Requests

This section covers the following topics:

5.1.5.1 – Managing Access to Interconnection Requests (page 78)
5.1.5.2 – Managing the Primary Representative of an Interconnection Request (page 82)

5.1.5.1 Managing Access to Interconnection Requests

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->IR Access/Contact from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT IR Access/Contact Info screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the Interconnection Request you wish to grant a user access to.

Step #6: The IRTT Modify IR Access/Contact Info screen will be displayed for that Interconnection Request. Click on “Add user” (plus sign icon) in the Manage IR User Access header to grant a user access to the selected Interconnection Request.
Step #7: The IRTT Add Existing User screen will be displayed. Select the user(s) you wish to grant access to and then click on “Add” at the bottom of the screen.

NOTE: You can return to the IRTT Modify IR Access/Contact Info screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #8: The IRTT Modify IR Access/Contact Info screen will be displayed and will present the user's access to the selected Interconnection Request.
5.1.5.2 Managing the Primary Representative of an Interconnection Request

Role this applies to:

- IRTT Customer Admin

NOTES:

- The user must have the IRTT Customer Admin role to perform this function. The first registered user account is automatically given this role. Subsequent user accounts can also be granted the IRTT Customer Admin role.
- To learn how a user account can be granted increased permissions, refer to the section titled “Managing Level of Access for a User Account” on page 72.
- For more information on the roles and their functions, refer to the section titled “IRTT Roles” on page 226.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->IR Access/Contact from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT IR Access/Contact Info screen will be displayed. Click on “Details” (pencil icon) at the right end of the record for the Interconnection Request you wish to modify the Primary Representative of.

Step #6: The IRTT Modify IR Access/Contact Info screen will be displayed for that Interconnection Request. Click on "Primary Representative" drop-down and click the desired user to be the Primary Representative for the selected Interconnection Request.
Step #7: IRTT will display a "Primary Representative" confirmation message. Click on "Yes" to modify the Primary Representative.

NOTE: You can return to the IRTT Modify IR Access/Contact Info screen without modifying the Primary Representative by clicking "No".

Step #8: The IRTT Modify IR Access/Contact Info screen will be displayed and the user will be presented as the Primary Representative.
5.2 IRTT User Interface Summary

The IRTT user interface is organized by a menu displayed on the left side of the IRTT screens. The access role of the individual user will determine the available functions. Each menu may be organized into additional organizational sub-menus. Each menu contains its own sections for viewing or editing your information.

5.2.1 IRTT Home Menu

The IRTT Home screen is the default screen that users see after their credentials are verified. It provides a summary of the interconnection requests associated with the corresponding company. It also provides a high level status of the Interconnection Requests for your company, including the phase in which the IR is currently in, the expected completion date of the phase, the next phase in the process, any delays and reasons for it, and study deposits and invoices associated with each Interconnection Request, among other things. The sections that follow will provide more details about the Home tab in general, and the IR Dashboard in particular.

The IRTT Home screen consists of four (4) main sections: a summary of IRs by status, the IR Dashboard, a summary of all IRs associated with the company, and a summary of IRs associated with the given user.

Summary of IRs by Status
This section provides users a count of Interconnection Requests in each status: Draft, Submitted, Valid, and Deficient. Clicking on a status value’s summary block will redirect you to the corresponding Interconnection Request view (equivalent to clicking Manage Requests-> in the IRTT menu on the left side of the screen).

IR Dashboard

The IR Dashboard provides a key summary of each associated Interconnection Request. It has three main components: IR Identification, IR Status, and IR Deposits and Balances.

**IR Identification**

The columns in the component provide the necessary information to identify each Interconnection Request. It specifically contains:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Position (QP)</td>
<td>The Queue Position (number) assigned to the project by ISO-NE.</td>
</tr>
<tr>
<td>Project Name</td>
<td>The name of the project submitted by the company.</td>
</tr>
<tr>
<td>Reference Number (Ref #)</td>
<td>A unique number assigned to the project by IRTT to maintain a unique reference to each Interconnection Request.</td>
</tr>
<tr>
<td>Type</td>
<td>Whether the Interconnection Request is a Large Generator, Small Generator, or Elective Transmission Upgrade project.</td>
</tr>
<tr>
<td>IR Submitted On</td>
<td>The date the Interconnection Request was initially submitted via IRTT.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IR Version</td>
<td>The current version number of the Interconnection Request.</td>
</tr>
<tr>
<td>IR Version Created On</td>
<td>The date the current version of the Interconnection Request was initially submitted via IRTT.</td>
</tr>
</tbody>
</table>

**IR Status**

The columns in this component provide information regarding the current phase and status of each Interconnection Request. This section of the Dashboard specifically provides users with information about the status of each IR, expected completion date, and reasons for delays, if any.

It specifically contains:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active / Withdrawn</td>
<td>The status of the Interconnection Request. Indicates whether the project is actively in the Queue or Withdrawn from the Queue.</td>
</tr>
<tr>
<td>Current Phase</td>
<td>The phase that the Interconnection Request is currently in (Feasibility Study, System Impact Study, etc.). Change in the Current Phase field will automatically trigger a Notice to be sent to users that have access to the given Interconnection Request.</td>
</tr>
<tr>
<td><strong>Current Phase Status</strong></td>
<td>The status of the phase that the Interconnection Request is currently in (Not Started, In Progress, etc.) Change in the Current Phase Status field will automatically trigger a Notice to be sent to users that have access to the given Interconnection Request.</td>
</tr>
<tr>
<td>Next Phase (if any)</td>
<td>The next phase of the Interconnection Request lifecycle.</td>
</tr>
<tr>
<td><strong>Expected Start Date of Current Phase</strong></td>
<td>The date when work associated with the Current Phase of the IR is expected to commence. Change in the Expected Start of Date of Current Phase field will automatically trigger a Notice to be sent to users that have access to the given Interconnection Request.</td>
</tr>
<tr>
<td><strong>Expected Completion Date of Current Phase</strong></td>
<td>The date when work associated with the Current Phase of the IR is expected to be completed. Change in the Expected Completion Date of Current Phase field will automatically trigger a Notice to be sent to users that have access to the given Interconnection Request.</td>
</tr>
</tbody>
</table>
**Reason for Delay (if any)**

The reason for delay, if any (Eg: Dependencies on prior queued studies still in progress prevent the study effort from fully completing). Change in the Reason for Delay (if any) field will automatically trigger a Notice to be sent to users that have access to the given Interconnection Request.

Requested Long Lead Facility

Identifies whether Long Lead Facility has been requested with the associated Interconnection Request (yes/no).

Requested Optional Preliminary Non-Binding Overlapping Impact

Identifies whether Requested Optional Preliminary Non-Binding Overlapping Impact analysis has been requested with the associated Interconnection Request, and the phase during which it has been requested (Feasibility vs. System Impact Study).

**Change in these fields will result in a Notice being sent. The Notice will be sent to the Customer Admin/IR Manager.**

**Current Phase Status Notice**

**Expected Start Date of Current Phase Notice**
**Expected Completion Date of Current Phase Notice**

**Interconnection Request phase status has been updated**

irttINTNew@iso-ne.com  
Sent: Mon 1/30/2017 10:43 AM  
To: redacted@gmail.com

The Facility Study Phase information for Interconnection Request # TCF-71637 has been updated.  
The Expected End date has been changed to 2/24/2017

**Reason for Delay (if any) Notice**

**Interconnection Request phase status has been updated**

irttINTNew@iso-ne.com  
Sent: Mon 1/30/2017 11:59 AM  
To: redacted@gmail.com

The Feasibility Study Phase information for Interconnection Request # TCF-71637 has been updated.  
The Reason for Delay has been changed to Material Modification Determination in progress

---

**IR Deposits and Balances**

The columns in this component provide information regarding the amount of financial deposit requested, collected, and spent for each Interconnection Request. It specifically contains:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total IR and Study Deposits Requested</td>
<td>The total amount of financial deposit requested by ISO-NE for the given Interconnection Request.</td>
</tr>
<tr>
<td>Total IR and Study Deposits Collected</td>
<td>The total amount of financial deposit submitted by the company for the given Interconnection Request.</td>
</tr>
<tr>
<td>NOTE: ISO-NE only accepts wire transfer of funds for deposits.</td>
<td></td>
</tr>
<tr>
<td>Total IR and Study Deposit Balance (as of)</td>
<td>The total financial deposit balance for the given Interconnection Request as of the current date/time.</td>
</tr>
</tbody>
</table>
Summary of all IRs associated with the Company

This section provides users with a summary of all of the Interconnection Requests submitted by the company whether or not the given user has been granted access to it.

### Company Interconnection Requests

<table>
<thead>
<tr>
<th>QP</th>
<th>A/W</th>
<th>Ver</th>
<th>Type</th>
<th>Submitted</th>
<th>Status</th>
<th>Project Name</th>
<th>Ref. #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>Large</td>
<td>Draft</td>
<td></td>
<td>Large Project One</td>
<td>-72464</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>Small</td>
<td>Draft</td>
<td></td>
<td>Small Project One</td>
<td>-29520</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>ETU</td>
<td>Draft</td>
<td></td>
<td>ETU Project One</td>
<td>-29946</td>
</tr>
</tbody>
</table>

Showing 1 to 3 of 3 entries

Summary of all IRs associated with the given User

This section provides users with a summary of only the Interconnection Requests submitted by the company the given user has been granted access to. Users can click on “View” (blue eye icon) to view the details of the selected Interconnection Request.

### Individual Interconnection Requests

<table>
<thead>
<tr>
<th>QP</th>
<th>A/W</th>
<th>Ver</th>
<th>Type</th>
<th>Submitted</th>
<th>Status</th>
<th>Project Name</th>
<th>Ref. #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>Large</td>
<td>Draft</td>
<td></td>
<td>Large Project One</td>
<td>-72464</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>Small</td>
<td>Draft</td>
<td></td>
<td>Small Project One</td>
<td>-29520</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>ETU</td>
<td>Draft</td>
<td></td>
<td>ETU Project One</td>
<td>-29946</td>
</tr>
</tbody>
</table>

Showing 1 to 3 of 3 entries
5.2.2 Manage Requests Menu

The Manage Requests menu contains sub-menus to:

- Submit new interconnection requests
  - “Submitting a new Large Generator Request” on page 95
  - “Submitting a new Small Generator Request” on page 115
- View lists of existing interconnection requests by current status (Draft, Pending Review, Submitted, Valid, and Deficient)
  - “Viewing Draft Interconnection Requests” on page 179
  - “Viewing Pending Review Interconnection Requests” on page 194
  - “Viewing Submitted Interconnection Requests” on page 197
  - “Viewing Deficient Interconnection Requests” on page 200
  - “Viewing Valid Interconnection Requests” on page 203
- Access the IRTT Supplemental Info Upload screen that allows a user to submit additional documentation after an interconnection request has been submitted.
  - “Submitting Supplemental Info Documentation” on page 150
- Access the IRTT Manage Request IR Access/Contact Info screen that allows an IRTT Customer Admin or IRTT IR Manager to grant access to individual interconnection requests to specific users for the company.
  - “Managing Access to Interconnection Requests” on page 78

5.2.3 Reports Menu

The Reports menu provides access to the Public Queue.

- “Viewing the IRTT Public Queue on page 221.”
5.2.4 Form Templates Menu

The Form Templates menu provides links to various Large and Small Interconnection Request and Elective Transmission Update (ETU) templates.
5.2.5 **Settings Menu**

The Settings menu allows users to modify the details of the associated company and user(s). This includes creating new user accounts, managing passwords, etc. Please see “Accessing IRTT” on page 9 for more information.

![Settings Menu](Image)

5.3 **Managing Interconnection Requests**

This section covers the following topics:

- 5.3.1 – Managing Interconnection Requests Overview (page 94)
- 5.3.2 – Submitting an Interconnection Request (page 95)
- 5.3.3 – Viewing an Interconnection Request (page 153)
- 5.3.4 – Viewing the IR Dashboard (page 218)
- 5.3.5 – Viewing the Public Queue (page 209)

5.3.1 **Managing Interconnection Requests Overview**

IRTT allows customers to draft and submit Interconnection Requests, correct or cure deficient Interconnection Requests, and view valid requests. The menus within IRTT indicate an Interconnection Request’s status and serve to indicate where a particular request stands.

An Interconnection Request’s status changes at various points throughout the processing lifecycle. A change in status triggers IRTT to send notifications and alerts to users to inform them when an action must occur, such as when a deficiency cure period starts.
**IMPORTANT!**

One important part of managing your company’s Interconnection Request is to monitor the information presented on the IRTT Home screen in the IR Dashboard.

The IR Dashboard provides important information regarding each Interconnection Request’s status and financial deposit amounts. It is ISO-NE’s primary method of communicating this information to Interconnection Customers.

For more information, please see:

- IRTT Home Menu on page 86 for a detailed description of the information presented in the IR Dashboard.
- Viewing the IR Dashboard on page 218 for specific instruction on how to access the IR Dashboard.

---

5.3.2 **Submitting an Interconnection Request**

This section covers the following topics:

- 5.3.2.1 – Submitting a new Large Generator Request (page 95)
- 5.3.2.2 – Submitting a new Small Generator Request (page 115)
- 5.3.2.3 – Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request (page 130)
- 5.3.2.4 – Modifying a Draft Interconnection Request (page 146)
- 5.3.2.5 – Submitting Supplemental Info Documentation (page 150)

5.3.2.1 **Submitting a new Large Generator Request**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.
Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->New IR from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Create Request screen will be displayed. All required data elements are noted with an asterisk (“*”).

Select “Large” in the Request Type drop down in order to submit a Large Generator Interconnection Request. Select the desired company in the Associated Company data element and provide a name in the Proposed Project Name data element.

Click on “Create” to continue.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #6: The IRTT Large Generator Requests screen will be displayed.

IMPORTANT!

- The Large Generator Interconnection Request has been created at this point in time. You can save your information and close the draft Interconnection Request at any time by clicking on “Close” at the bottom of the screen.
- The Manage Requests-> Draft IRs screen will be displayed and the draft Interconnection Request will be presented. See Viewing a Summary of Draft Interconnection Requests on page 191 for more information.
- You can continue to modify the draft Interconnection Request at any time by clicking on the “Edit” (pencil icon) at the right end of the record for the draft Interconnection Request. See Modifying a Draft Interconnection Request on page 146 for more information.
The Large Generator Interconnection Request screen has four (4) main tabs which must be completed: Project, Signature, Technical, and Uploads.

Step #7: Click on the “Project” tab and then click on “Edit” at the bottom of the screen.

Make note of the required documentation uploads as follows:

- Site Map
- Site Control Evidence

Step #8: Click on the “Uploads” tab. Submit each of the required documents by clicking on “Add” (plus sign icon) in the Attachments header.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #9: The IRTT Upload Attachment UI will be displayed. All required data elements are noted with an asterisk (“*”).

Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the “Uploads” tab by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #10: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #11: Once there are no submission issues, the “Uploads” tab will be re-displayed and you can repeat Step #8 through Step #10 to upload additional attachments as necessary.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #12: Click on the “Project” tab again. Submit the remaining Project information. All required data elements are noted with an asterisk (“*”).

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Fields marked with an asterisk (*) are required and must be filled in prior to submitting.

### Project Name
- **Proposed Project Name**: Large Project One
- **Reference ID**: -59241

**This Interconnection Request is for**
- A proposed new Generating Facility
- An increase in the generating capacity or a modification that has the potential to be a Material Modification of an existing Generation Family
- Commencement of participation in the wholesale markets by an existing Generating Facility
- A change from Network Resource Interconnection Service to Capacity Network Resource Interconnection Service

**The type of Interconnection Service requested**
- Network Resource Interconnection Service (energy capability only)
- Capacity Network Resource Interconnection Service (energy capability & capacity capability)

**This Interconnection Customer requests**
- An Interconnection Feasibility Study to be completed as a separate and distinct study
- An Interconnection System Impact Study with the Feasibility Study to be performed as the first step of the study
- Not known at this time (make this selection later)
Interconnection Customer shall provide the following information

Address or Location of the Facility (Including Town/City, County & State)

<table>
<thead>
<tr>
<th>Name</th>
<th>City</th>
<th>State</th>
<th>County</th>
<th>Zip</th>
</tr>
</thead>
</table>

There are currently no Locations associated with this Request

Add new

Approximate location of the proposed Point of Interconnection *
(information not required as part of the initial Interconnection Request):

Format should include owner of POI, voltage level and name (ex: CMP 115 kv Line 229). Also, please note that all information entered here is visible on the queue to all parties.

Site Maps

Use "Uploads" tab to attach a Site Map

- Click this checkbox to designate that you have uploaded a valid Site Map document.

Use "Uploads" tab to attach the Site Control Evidence

- Site maps must be legible when printed on 8½ x 11 or legal-size paper
- Supported File Types include: PDF, JPEG, or PNG images
- Individual file size can not exceed 2.5 MB

- Click this checkbox to designate that you have uploaded a valid Site Control document.

- If for Network Resource Interconnection Service: In lieu of evidence of Site Control, a $10,000 deposit is provided herewith (refundable within the cure period as described in Section 3.3.3 of the LGIP).

- Site Control is not provided because the proposed modification is to the Interconnection Customer’s existing Large Generating Facility and, by checking this option, the Interconnection Customer certifies that it has Site Control and that the proposed modification does not require additional real property.
Step #13: Click on the “Technical” tab.

Step #14: Submit the System Impact Study (Attachment A) information by clicking on “Add” (blue colored plus sign) in the System Impact Studies (Attachment A) section header.
Step #15: The IRTT Add System Impact Study screen will be displayed. Submit the required study information. All required data elements are noted with an asterisk ("*").

Click on “Create”.

NOTE: You can return to the “Technical” tab by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #16: The “Technical” tab will be re-displayed.

Step #17: Submit the Feasibility Study (Attachment B) information by clicking on “Add” (blue colored plus sign) in the Feasibility Studies (Attachment B) section header.
Step #18: The IRTT Add Feasibility Study screen will be displayed. Submit the required study information. All required data elements are noted with an asterisk ("*”).

Click on “Create”.

NOTE: You can return to the “Technical” tab by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #19: The “Technical” tab will be re-displayed.

Once the study information has been added, it can be modified by clicking on “Edit” (pencil icon) on each record or it can be deleted by clicking on “Delete” (red colored ‘x’ icon).

Step #20: Click on the “Signature” tab. Make note of the required documentation uploads as follows:

- Signature Page – Interconnection Request
- Signature Page – Attachment A (if necessary)
- Attachment A-1 (signed) (if necessary)
- Signature Page – Attachment B (if necessary)
Step #21: Click on the "Uploads" tab. Submit each of the required documents by clicking on “Add” (plus sign icon) in the Attachments header.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #22: The IRTT Upload Attachment UI will be displayed. All required data elements are noted with an asterisk (*).

Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the “Uploads” tab by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #23: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #24: Once there are no submission issues, the “Uploads” tab will be re-displayed and you can repeat Step #21 through Step #23 to upload additional attachments as necessary.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #25: Click on the “Signature” tab again. Confirm that the required documentation has been uploaded (or is un-necessary). All required data elements are noted with an asterisk (“*”).

Step #26: Click on “Save” to save all of the above submissions.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Fields marked with an asterisk (*) are required and must be filled in prior to submitting.

**Signature Page**

**Upload Applicant Signature Page**
Use the "Uploads" tab to upload and attach a scanned, signed signature page for this Interconnection Request. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

**Signature Certification**
- [ ] I hereby certify that I have uploaded a signed Interconnection Request signature page.

**Upload Attachment A Signature Page**
Use the "Uploads" tab to upload and attach a scanned, signed signature page for this request’s Attachment A forms, if applicable. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

**Is Attachment A Enclosed?**
- [ ] I hereby certify that I have uploaded a signed Attachment A signature page.
- [ ] I certify that no Attachment A is supplied at this time.

**Signature Page**
Print Signature Page - Interconnection Request
Print Signature Page - Attachment A
Step #27: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #28: Once there are no submission issues, the “Signature” tab will be re-displayed.

Step #29: Once you have submitted all of the required information to the best of your knowledge, click on “Submit”.
Step #30: IRTT will display a “Submit Large Request” confirmation message. Click on “Yes” to formally submit the Large Generator Interconnection Request to ISO-NE.

NOTE: You can return to the IRTT Large Generator Request screen without formally submitting the Large Generator Interconnection Request to ISO-NE by clicking “No”.

Step #31: The IRTT Draft IRs screen will be displayed.

Step #32: IRTT will also notify the user assigned as the Primary Representative that the Interconnection Request has been submitted and received via an e-mail.
5.3.2.2 **Submitting a new Small Generator Request**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager

Step #1: Navigate to the ISO New England Application Portal at: [https://portal.iso-ne.com](https://portal.iso-ne.com). The ISO New England Application Portal screen will be displayed. Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->New IR from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Create Request screen will be displayed. All required data elements are noted with an asterisk (*). Select “Small” in the Request Type drop down in order to submit a Small Generator Interconnection Request. Select the desired company in the Associated Company data element and provide a name in the Proposed Project Name data element. Click on “Create” to continue.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #6: The IRTT Small Generator Request screen will be displayed.

IMPORTANT!

- The Small Generator Interconnection Request has been created at this point in time. You can save your information and close the draft Interconnection Request at any time by clicking on “Close” at the bottom of the screen.
- The Manage Requests-> Draft IRs screen will be displayed and the draft Interconnection Request will be presented. See Viewing a Summary of Draft Interconnection Requests on page 191 for more information.
- You can continue to modify the draft Interconnection Request at any time by clicking on the “Edit” (pencil icon) at the right end of the record for the draft Interconnection Request. See Modifying a Draft Interconnection Request on page 146 for more information.
The Small Generator Interconnection Request screen has five (5) main tabs which must be completed: Project, General, Signature, Technical, and Uploads.

Step #7:  Click on the “Project” tab and then click on “Edit” at the bottom of the screen.

Step #8:  Submit the required Project information. All required data elements are noted with an asterisk (“*”).

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #9: Click on the “Technical” tab. Submit the required Technical information (other than noted in Step #10 below). All required data elements are noted with an asterisk (“*”).

Step #10: Submit the following information by clicking on “Add” (blue colored plus sign) in each of the corresponding section headers:

- Generators
- Small Generating Facility Characteristic Data (for Inverter-based Machines)
- Small Generating Facility Characteristic Data (for Rotating Machines)
- Interconnection Facilities Information (Transformers)
- Interconnecting Circuit Breaker
NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #11: The corresponding screen will be displayed. Submit the required information. All required data elements are noted with an asterisk (“*”).

Click on “Create”.
NOTE: You can return to the “Technical” tab by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #12: The “Technical” tab will be re-displayed.

Once the information has been added, it can be modified by clicking on “Edit” (pencil icon) on each record or it can be deleted by clicking on “Delete” (red colored ‘x’ icon).

Step #13: Click on the “General” tab.

Make note of the required documentation uploads as follows:

- Site Electrical One-line Diagram
- Site Control Documentation
- Protection & Control Schemes
- Protection & Control Circuits
Step #14: Click on the "Uploads" tab. Submit each of the required documents by clicking on "Add" (plus sign icon) in the Attachments header.

NOTE: You can return to the IRTT Draft IRs screen by clicking "Close" at the bottom of the screen. No submitted information will be validated or saved.
Step #15: The IRTT Upload Attachment UI will be displayed. All required data elements are noted with an asterisk (“*”).

Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the “Uploads” tab by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #16: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #17: Once there are no submission issues, the “Uploads” tab will be re-displayed and you can repeat Step #14 through Step #16 to upload additional attachments as necessary.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #18: Click on the "General" tab again. Submit the remaining General information. All required data elements are noted with an asterisk ("*").

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #19: Click on the "Signature" tab. Make note of the required documentation uploads as follows:

- Signature Page – Interconnection Request
- Attachment A (signed)
Step #20: Click on the “Uploads” tab. Submit each of the required documents by clicking on “Add” (plus sign icon) in the Attachments header.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #21: The IRTT Upload Attachment UI will be displayed. All required data elements are noted with an asterisk (“*”).

Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the “Uploads” tab by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #22:  IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #23:  Once there are no submission issues, the “Uploads” tab will be re-displayed and you can repeat Step #20 through Step #22 to upload additional attachments as necessary.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #24:  Click on the “Signature” tab again. Confirm that the required documentation has been uploaded. All required data elements are noted with an asterisk (“*”).

Step #25:  Click on “Save” to save all of the above submissions.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #26: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #27: Once there are no submission issues, the “Signature” tab will be re-displayed.

Step #28: Once you have submitted all of the required information to the best of your knowledge, click on “Submit”.

IRTTE User Guide Version 3.0
Step #29: IRTT will display a “Submit Small Request” confirmation message. Click on “Yes” to formally submit the Small Generator Interconnection Request to ISO-NE.

NOTE: You can return to the IRTT Small Generator Request screen without formally submitting the Small Generator Interconnection Request to ISO-NE by clicking “No”.

Step #30: The IRTT Draft IRs screen will be displayed.

Step #31: IRTT will also notify the user assigned as the Primary Representative that the Interconnection Request has been submitted and received via an e-mail.

5.3.2.3 Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->New IR from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Create Request screen will be displayed. All required data elements are noted with an asterisk (“*”).

Select “ETU” in the Request Type drop down in order to submit an Elective Transmission Upgrade (ETU) Interconnection Request. Select the desired company in the Associated Company data element and provide a name in the Proposed Project Name data element.

Click on “Create” to continue.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #6: The IRTT Elective Transmission Upgrade Request screen will be displayed.

IMPORTANT!
- The Elective Transmission Upgrade Interconnection Request has been created at this point in time. You can save your information and close the draft Interconnection Request at any time by clicking on “Close” at the bottom of the screen.

- The Manage Requests-> Draft IRs screen will be displayed and the draft Interconnection Request will be presented. See Viewing a Summary of Draft Interconnection Requests on page 191 for more information.

- You can continue to modify the draft Interconnection Request at any time by clicking on the “Edit” (pencil icon) at the right end of the record for the draft Interconnection Request. See Modifying a Draft Interconnection Request on page 146 for more information.

The Elective Transmission Upgrade Interconnection Request screen has four (4) main tabs which must be completed: Project, Signature, Technical, and Uploads.

**Step #7:** Click on the “Project” tab and then click on “Edit” at the bottom of the screen.

**Step #8:** Submit the required Project information. All required data elements are noted with an asterisk (“*”).

**NOTE:** You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Requests Elective Transmission Upgrade

Fields marked with an asterisk (*) are required and must be filled in order to submitting

ETU Project One

Project Information

Proposed Project Name *
ETU Project One

Reference ID
39946

Description of the ETU objective (select one of a, b, c, d, or e):

- a. Addition of a specific technology
- b. Modification to existing PTF, MTF or OTF that is part of or interconnected to the Administered Transmission System
- c. Specific performance objective associated with specific Generating Facility(ies)/resources:
- d. Increase in transfer capability between points, including
- e. Other specific and clearly described discrete objective

Projected Dates

Requested Commercial Operations
Requested In Service Date *
Requested Initial Synchronization Date *

This Interconnection Request is for (check either Internal ETU or External ETU options)

- an Internal ETU (check one of i or ii)
- an External ETU (check i or ii and specify the other Control Area interconnecting)
Step #9:  Click on the “Technical” tab.

Step #10: Submit the System Impact Study (Attachment A) information by clicking on “Add” (blue colored plus sign) in the System Impact Studies (Attachment A) section header.
Step #11: The IRTT Add System Impact Study screen will be displayed. Submit the required study information. All required data elements are noted with an asterisk (“*”).

Click on “Create”.

NOTE: You can return to the “Technical” tab by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #12: The “Technical” tab will be re-displayed.

Step #13: Submit the Feasibility Study (Attachment B) information by clicking on “Add” (blue colored plus sign) in the Feasibility Studies (Attachment B) section header.
Step #14: The IRTT Add Feasibility Study screen will be displayed. Submit the required study information. All required data elements are noted with an asterisk (“*”).

Click on “Create”.

NOTE: You can return to the “Technical” tab by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #15: The “Technical” tab will be re-displayed.

Once the study information has been added, it can be modified by clicking on “Edit” (pencil icon) on each record or it can be deleted by clicking on “Delete” (red colored ‘x’ icon).

Step #16: Click on the “Signature” tab. Make note of the required documentation uploads as follows:

- Signature Page – Interconnection Request
- Signature Page – Attachment A (if necessary)
- Signature Page – Attachment B (if necessary)
Step #17: Click on the "Uploads" tab. Submit each of the required documents by clicking on “Add” (plus sign icon) in the Attachments header.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.

Step #18: The IRTT Upload Attachment UI will be displayed. All required data elements are noted with an asterisk (*).
Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the “Uploads” tab by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.

Step #19: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #20: Once there are no submission issues, the “Uploads” tab will be re-displayed and you can repeat Step #17 through Step #19 to upload additional attachments as necessary.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #21: Click on the “Signature” tab again. Confirm that the required documentation has been uploaded (or is un-necessary). All required data elements are noted with an asterisk (*).

Step #22: Click on “Save” to save all of the above submissions.

NOTE: You can return to the IRTT Draft IRs screen by clicking “Close” at the bottom of the screen. No submitted information will be validated or saved.
Step #23: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #24: Once there are no submission issues, the “Signature” tab will be re-displayed.

Step #25: Once you have submitted all of the required information to the best of your knowledge, click on “Submit”.
Step #26: IRTT will display a “Submit ETU Request?” confirmation message. Click on “Yes” to formally submit the Elective Transmission Upgrade Interconnection Request to ISO-NE.

NOTE: You can return to the IRTT Elective Transmission Upgrade Request screen without formally submitting the Elective Transmission Upgrade Interconnection Request to ISO-NE by clicking “No”.
Step #27: The IRTT Draft IRs screen will be displayed.

Step #28: IRTT will also notify the user assigned as the Primary Representative that the Interconnection Request has been submitted and received via an e-mail.

5.3.2.4 Modifying a Draft Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Draft IRs from the IRTT menu on the left side of the IRTT Home screen or click on the blue colored “Draft IRs” summary block.
Step #5: The IRTT Draft IRs screen will be displayed.

You can use the “Select Company to Manage”, “Select Generator Type” filters, or enter a text string to search through all columns, if desired.

Select “Edit” (pencil icon) at the right end of the record for the Interconnection Request you want to modify.

Step #6: Depending on the Type of Interconnection Request (Large Generator, Small Generator, or Elective Transmission Upgrade), the corresponding IRTT screen will be displayed:

- IRTT Large Generator Requests screen
- IRTT Small Generator Requests screen
- IRTT Elective Transmission Upgrade Requests screen

Step #7: Modify the Interconnection Request information as needed. For more information on each Interconnection Request type’s information, please see:

- Large Generator Requests: See Submitting a new Large Generator Request on page 95.
- Small Generator Requests: See Submitting a new Small Generator Request on page 115.
• Elective Transmission Upgrade Requests: See Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request on page 130.

5.3.2.5 Submitting Supplemental Info Documentation

Role this applies to:

➢ IRTT Customer Admin
➢ IRTTT IR Manager


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Supplemental Info from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Supplemental Info Upload screen will be displayed.

You can use the “Select Company to Manage”, “Select Generator Type” filters, or enter a text string to search through all columns, if desired.

Step #6: Select “Upload Document” (blue plus sign icon) at the right end of the record for the Interconnection Request you want to upload supplemental info (documentation) to.

Step #7: The IRTT Upload Attachment screen will be displayed. All required data elements are noted with an asterisk (“*”).

Select the corresponding entry in the Attachment Type data element. Click “Browse” to navigate to and select the desired folder and file. Enter a Comment if necessary to add additional information regarding the attachment.

Click on “Upload”.

NOTE: You can return to the IRTT Supplemental Info Upload screen by clicking “Cancel” at the bottom of the screen. No submitted information will be validated or saved.
Step #8: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #9: Once there are no submission issues, the IRTT Supplemental Info Upload screen will be re-displayed and you can repeat Step #6 through Step #8 to upload additional attachments as necessary.

5.3.3 Viewing an Interconnection Request & curing Deficient Interconnection Requests

This section covers the following topics:

5.3.3.1 – Viewing a Large Generator Request & Curing Deficient Interconnection Request (page 154)
5.3.3.2 – Viewing a Small Generator Request & Curing Deficient Interconnection Request (page 171)
5.3.3.3 – Viewing an Elective Transmission Upgrade (ETU) Interconnection Request Curing Deficient Interconnection Request (page 185)
5.3.3.4 – Viewing a Summary of Draft Interconnection Requests (page 196)
5.3.3.5 – Viewing a Summary of Pending Review Interconnection Requests (page 199)
5.3.3.6 – Viewing a Summary of Submitted Interconnection Requests (page 202)
5.3.3.7 – Viewing a Summary of Deficient Interconnection Requests (page 205)
5.3.3.1 Viewing a Large Generator Request & curing a Deficient Large Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

IMPORTANT!

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.
- Only IRTT Customer Admin and IRTT IR Manager can cure Deficient Interconnection Requests.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select “View” (blue colored eye icon) at the right end of the record for the Large Generator Interconnection Request in the Individual Interconnection Requests section (bottom right corner) you wish view.

![Step #4:](image)

Step #5: The IRTT Large Generator Requests screen will be displayed and will present the details of the selected Interconnection Request.

The Large Generator Interconnection Request screen has four (4) main tabs: Project, Signature, Technical, and Uploads.

Step #6: Click on the “Project” tab to view the Project Information.
### Project Information

<table>
<thead>
<tr>
<th>Proposed Project Name *</th>
<th>Reference ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Project One</td>
<td>-72464</td>
</tr>
</tbody>
</table>

**This Interconnection Request is for**  
- A proposed new Generating Facility  
- An increase in the generating capacity or a modification that has the potential to be a Material Modification of an existing Generation Family  
- Commencement of participation in the wholesale markets by an existing Generating Facility  
- A change from Network Resource Interconnection Service to Capacity Network Resource Interconnection Service

**The type of Interconnection Service requested**  
- Network Resource Interconnection Service (energy capability only)  
- Capacity Network Resource Interconnection Service (energy capability & capacity capability)

**This Interconnection Customer requests**  
- An Interconnection Feasibility Study to be completed as a separate and distinct study  
- An Interconnection System Impact Study with the Feasibility Study to be performed as the first step of the study  
- Not known at this time (make this selection later)
Interconnection Customer shall provide the following information

Address or Location of the Facility (including Town/City, County & State)

<table>
<thead>
<tr>
<th>Name</th>
<th>City</th>
<th>State</th>
<th>County</th>
<th>Zip</th>
</tr>
</thead>
</table>

There are currently no Locations associated with this Request

Approximate location of the proposed Point of Interconnection *
(information not required as part of the initial Interconnection Request):

Format should include owner of POI, voltage level and name (ex: CMP 115 kv Line 229). Also, please note that all information entered here is visible on the queue to all parties.

Site Maps

Use "Uploads" tab to attach a Site Map

☐ Click this checkbox to designate that you have uploaded a valid Site Map document.

• Site maps must be legible when printed on 8½ x 11 or legal-size paper
• Supported File Types include: PDF, JPEG, or PNG Images
• Individual file size can not exceed 2.5 MB

Use "Uploads" tab to attach the Site Control Evidence

☐ Click this checkbox to designate that you have uploaded a valid Site Control document.

☐ If for Network Resource Interconnection Service: In lieu of evidence of Site Control, a $10,000 deposit is provided herewith (refundable within the cure period as described in Section 3.3.3 of the LGIP).

☐ Site Control is not provided because the proposed modification is to the Interconnection Customer’s existing Large Generating Facility and, by checking this option, the Interconnection Customer certifies that it has Site Control and that the proposed modification does not require additional real property.
Type of Generating Facility to be Constructed *

Generating Facility Fuel Type(s) *

- Agricultural Byproducts
- Blast-Furnace Gas
- Bituminous Coal
- Black Liquor
- Distillate Fuel Oil
- Geothermal
- Jet Fuel
- Kerosene
- N/A
- Landfill Gas
- Lignite Coal
- Municipal Solid Waste
- Natural Gas
- Nuclear
- Other Biomass Gases
- Other Biomass Liquids
- Other Biomass Solids
- Other Gas
- Other
- Petroleum Coke
- Propane
- Residual Fuel Oil
- Coal-based Synfuels
- Sludge Waste
- Sub-bituminous Coal
- Solar
- Tires
- Water
- Waste/Other Coal
- Wood Waste Liquids
- Wood/Wood Waste Solids
- Wind
- Oil

<table>
<thead>
<tr>
<th>Maximum Net MW Electrical Output</th>
<th>Maximum Gross MW Electrical Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT 90 °F or higher *</td>
<td>Net @ 90</td>
</tr>
<tr>
<td>AT 50 °F or higher *</td>
<td>Net @ 50</td>
</tr>
<tr>
<td>AT 20 °F or higher *</td>
<td>Net @ 20</td>
</tr>
<tr>
<td>AT 0 °F or higher *</td>
<td>Net @ 0</td>
</tr>
</tbody>
</table>

General description of the equipment configuration (# of units and GSUs) *
Step #7: Click on the “Technical” tab to view the Technical Information.
Step #8: Click on the “Uploads” tab to view the uploaded documentation.
Step #9: Click on the “Signature” tab to view the Signature Page.
Requests Large Generator

Large Project One

Signature Page

Upload Applicant Signature Page

Use the "Uploads" tab to upload and attach a scanned, signed signature page for this Interconnection Request. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

Signature Certification

☐ I hereby certify that I have uploaded a signed Interconnection Request signature page.

Upload Attachment A Signature Page

Use the "Uploads" tab to upload and attach a scanned, signed signature page for this request’s Attachment A forms, if applicable. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

Is Attachment A Enclosed?

☐ I hereby certify that I have uploaded a signed Attachment A signature page.

☐ I certify that no Attachment A is supplied at this time.
Step #10: To cure a Deficient Interconnection Request click on the Deficient IRs tab of the Manage Requests tab.

Select View Validation icon. This will open a window containing the Deficient Request Validation Information screen.

Click on the Create New Version link.

Select “yes” on the Create New Request Version alert.

Go to the Draft IRs tab of the Manage Requests tab. The new version of the Interconnection Request that you just created will be listed shown there.

Select the Edit icon. This will open the new version of the Interconnection Request that was just created.
Click on the Edit button on the bottom of the page. This will allow you to edit the Interconnection Request and to resubmit it. For more information on how to submit an Interconnection Request, refer to section 5.3.2 (Submitting an Interconnection Request) of this User Guide.
### Request Validation Information Test 2

**Validation Status:** Deficient

#### Project Information

- **Address or Location of the Facility:**
  - Approved: Yes
  - Comments

- **Approximate location of the proposed Point of Interconnection:**
  - Approved: Yes
  - Comments

- **Type of Generating Facility to be Constructed:**
  - Approved: Yes
  - Comments

- **Long Lead Treatment:**
  - Approved: Yes
  - Comments

- **Generating Facility Fuel Type:**
  - Approved: Yes
  - Comments

#### Technical Information

- **System Impact Study (Attachment A) Technical Data Valid?**
  - Approved: Yes
  - Comments

- **Feasibility Study (Attachment B) Technical Data Valid?**
  - Approved: Yes
  - Comments

---

This request has been flagged as Deficient. You can re-submit this request by creating a new version of the request, complete missing information and then re-submit from the "Draft" folder. Would you like to create a new version? Yes

---

Be sure to include all additional Attachment A/B with your validation:

- **Technical Approver Validated System Impact Study**
  - Yes, No
- **Technical Approver Validated Feasibility Study**
  - Yes, No
<table>
<thead>
<tr>
<th>Maximum Net MWh Electrical Output</th>
<th>Maximum Gross MWh Electrical Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT 16 &quot;9 or higher&quot;</td>
<td>AT 16 &quot;9 or higher&quot;</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>AT 16 &quot;9 or higher&quot;</td>
<td>AT 16 &quot;9 or higher&quot;</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>AT 20 &quot;9 or higher&quot;</td>
<td>AT 20 &quot;9 or higher&quot;</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>AT 0.9 &quot;9 or higher&quot;</td>
<td>AT 0.9 &quot;9 or higher&quot;</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
</tr>
</tbody>
</table>

General description of the equipment configuration (if of units and GIS)**

<table>
<thead>
<tr>
<th>Requested Commercial Operations Date</th>
<th>Requested In Service Date</th>
<th>Requested Initial Synchronization Date</th>
</tr>
</thead>
</table>
5.3.3.2 Viewing a Small Generator Request & curing a Small Deficient Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.
- Only IRTT Customer Admin and IRTT IR Manager can cure Deficient Interconnection Requests.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select “View” (blue colored eye icon) at the right end of the record for the Small Generator Interconnection Request in the Individual Interconnection Requests section (bottom right corner) you wish view.

Step #5: The IRTT Small Generator Requests screen will be displayed and will present the details of the selected Interconnection Request.

The Small Generator Interconnection Request screen has five (5) main tabs: Project, General, Signature, Technical, and Uploads.

Step #6: Click on the “Project” tab to view the Project Information.
Project Information

Proposed Project Name
Small Project One

Reference ID
20320

Facility Locations (if different from above)

Application is for
- New Small Generating Facility
- An increase in the generating capacity or a modification that has the potential to be a Material Modification of an existing Generation Family
- Commencement of participation in the wholesale markets by an Existing Small Generating Facility
- A change from Network Resource Interconnection Service to Capacity Network Resource Interconnection Service

If capacity addition to or modification of an existing facility, please describe:

If the capacity addition increases the maximum gross megawatt electrical output at an ambient temperature of 20 degrees F of the Generating Facility to more than 20 MW, the interconnection Customer shall apply under Schedule 22.
Will the Small Generating Facility be used for any of the following?

Net Metering? *
- Yes
- No

To Supply Power to the Interconnection Customer? *
- Yes
- No

To Supply Power to Others? *
- Yes
- No

Service Type *
- Select -

A retail customer interconnecting a new Small Generating Facility that will produce electric energy to be consumed only on the retail customer's site? *
- Yes
- No

A qualifying Facility where 100% of the output will be sold to its host utility? *
- Yes
- No

An Interconnection Customer interconnecting a new Small Generating Facility that plans to participate in the wholesale markets? *
- Yes
- No

An existing Small Generating Facility commencing participation in the wholesale markets? *
- Yes
- No

Locations with existing electrical service:
For installations at locations with existing electric service to which the proposed Small Generating Facility will interconnect, provide:

<table>
<thead>
<tr>
<th>Local Electric Service Provider *</th>
<th>Existing Account Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required *</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contact Name</th>
<th>Contact Title</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>E-mail Address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phone (day)</th>
<th>Phone (evening)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Step #7: Click on the “General” tab to view the General Information.
Step #8: Click on the “Technical” tab to view the Technical Information.
Step #9: Click on the “Uploads” tab to view the uploaded documentation.
Step #10: Click on the “Signature” tab to view the Signature Page.
Step #11: To cure a Deficient Interconnection Request click on the Deficient IRs tab of the Manage Requests tab.

Select View Validation icon. This will open a window containing the Deficient Request Validation Information screen.

Click on the Create New Version link.

Select “yes” on the Create New Request Version alert.

Go to the Draft IRs tab of the Manage Requests tab. The new version of the Interconnection Request that you just created will be listed shown there.

Select the Edit icon. This will open the new version of the Interconnection Request that was just created.

Click on the Edit button on the bottom of the page. This will allow you to edit the Interconnection Request and to resubmit it. For more information on how to submit an Interconnection Request, refer to section 5.3.2 (Submitting an Interconnection Request) of this User Guide.
## Request Validation Information Test 2

**Test 2 (TCF-88638)**

<table>
<thead>
<tr>
<th>Validation Status:</th>
<th>Deficient</th>
</tr>
</thead>
</table>

### Project Information

<table>
<thead>
<tr>
<th>Approved</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Address or Location of the Facility:**

<table>
<thead>
<tr>
<th>Approved</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Approximate Location of the Proposed Point of Interconnection:**

<table>
<thead>
<tr>
<th>Approved</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

### Technical Information

**Technical Information:**

<table>
<thead>
<tr>
<th>System Impact Study (Attachment A) Technical Data Valid?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
</tr>
<tr>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feasibility Study (Attachment B) Technical Data Valid?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
</tr>
<tr>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>

Be sure to include all additional Attachment A/B/C with your validation:

- **Technical Approver Validated System Impact Study**
- **Technical Approver Validated Feasibility Study**
<table>
<thead>
<tr>
<th>Maximum Net MWh Electrical Output</th>
<th>Maximum Gross MWh Electrical Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT 16' 9' or higher*</td>
<td>1</td>
</tr>
<tr>
<td>AT 16' 9' or higher</td>
<td>2</td>
</tr>
<tr>
<td>AT 20' 9' or higher</td>
<td>3</td>
</tr>
<tr>
<td>AT 25' 9' or higher</td>
<td>4</td>
</tr>
<tr>
<td>AT 30' 9' or higher</td>
<td>5</td>
</tr>
</tbody>
</table>

General description of the equipment configuration (if of units and CIGs)*

Requested Commercial Operations Date * | Requested In Service Date * | Requested Initial Synchronization Date *
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>12/16/2016</td>
<td>12/16/2016</td>
<td>12/16/2016</td>
</tr>
</tbody>
</table>
5.3.3.3 Viewing an Elective Transmission Upgrade (ETU) Interconnection Request & curing a Deficient Elective Transmission Upgrade (ETU) Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England's IRTT Administrator via e-mail at IRTT@iso-ne.com.
- Only IRTT Customer Admin and IRTT IR Manager can cure Deficient Interconnection Requests.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select “View” (blue colored eye icon) at the right end of the record for the Elective Transmission Upgrade Interconnection Request in the Individual Interconnection Requests section (bottom right corner) you wish view.

Step #5: The IRTT Elective Transmission Upgrade Requests screen will be displayed and will present the details of the selected Interconnection Request.

The Elective Transmission Upgrade Interconnection Request screen has four (4) main tabs: Project, Signature, Technical, and Uploads.

Step #6: Click on the “Project” tab to view the Project Information.
# Requests: Elective Transmission Upgrade

## ETU Project One

### Project Information

<table>
<thead>
<tr>
<th>Proposed Project Name</th>
<th>Reference ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETU Project One</td>
<td>-29946</td>
</tr>
</tbody>
</table>

**Description of the ETU objective (select one of a, b, c, d, or e):**
- [ ] a. Addition of a specific technology
- [ ] b. Modification to existing PTF, MTF or OTF that is part of or interconnected to the Administered Transmission System
- [ ] c. Specific performance objective associated with specific Generating Facility(ies)/resources:
- [ ] d. Increase in transfer capability between points, including
- [ ] e. Other specific and clearly described discrete objective

### Projected Dates

<table>
<thead>
<tr>
<th>Requested Commercial Operations Date</th>
<th>Requested In Service Date</th>
<th>Requested Initial Synchronization Date</th>
</tr>
</thead>
</table>

**This Interconnection Request is for (check either Internal ETU or External ETU options):**
- [ ] an **Internal ETU** (check one of i or ii)
- [ ] an **External ETU** (check i or ii or iii and specify the other Control Area interconnecting)
Step #7: Click on the “Technical” tab to view the Technical Information.
Step #8: Click on the “Uploads” tab to view the uploaded documentation.
Step #9:  Click on the “Signature” tab to view the Signature Page.
Signature Page

Upload Applicant Signature Page

Use the "Uploads" tab to upload and attach a scanned, signed signature page for this Interconnection Request. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

Signature Certification

- I hereby certify that I have uploaded a signed Interconnection Request signature page.

Upload Attachment A Signature Page

Use the "Uploads" tab to upload and attach a scanned, signed signature page for this request's Attachment A forms, if applicable. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

Is Attachment A Enclosed?

- I hereby certify that I have uploaded a signed Attachment A signature page.
- I certify that no Attachment A is supplied at this time.

Upload Attachment B Signature Page

Use the "Uploads" tab to upload and attach a scanned, signed signature page for this request's Attachment B forms, if applicable. The original signed Applicant signature page must be sent to ISO New England to accompany the digital request on file.

Is Attachment B Enclosed?

- I hereby certify that I have uploaded a signed Attachment B signature page.
- I certify that no Attachment B is supplied at this time.
Step #10: To cure a Deficient Interconnection Request click on the Deficient IRs tab of the Manage Requests tab.

Select View Validation icon. This will open a window containing the Deficient Request Validation Information screen.

Click on the Create New Version link.

Select “yes” on the Create New Request Version alert.

Go to the Draft IRs tab of the Manage Requests tab. The new version of the Interconnection Request that you just created will be listed shown there.

Select the Edit icon. This will open the new version of the Interconnection Request that was just created.

Click on the Edit button on the bottom of the page. This will allow you to edit the Interconnection Request and to resubmit it. For more information on how to submit an Interconnection Request, refer to section 5.3.2 (Submitting an Interconnection Request) of this User Guide.
### Request Validation Information Test 2

<table>
<thead>
<tr>
<th>Project Information</th>
<th>Technical Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address or Location of the Facility:</strong></td>
<td><strong>System Impact Study (Attachment A) Technical Data Valid?</strong></td>
</tr>
<tr>
<td>Approved</td>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Approximate location of the proposed Point of Interconnection:</strong></td>
<td><strong>Feasibility Study (Attachment B) Technical Data Valid?</strong></td>
</tr>
<tr>
<td>Approved</td>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Type of Generating Facility to be Constructed:</strong></td>
<td></td>
</tr>
<tr>
<td>Approved</td>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Long Lead Treatment:</strong></td>
<td></td>
</tr>
<tr>
<td>Approved</td>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Generating Facility Fuel Type:</strong></td>
<td></td>
</tr>
<tr>
<td>Approved</td>
<td>Comments</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
5.3.3.4 Viewing a Summary of Draft Interconnection Requests

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

IMPORTANT!

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Draft IRs from the IRTT menu on the left side of the IRTT Home screen or click on the blue colored “Draft IRs” summary block.

Step #5: The IRTT Draft IRs screen will be displayed.

You can use the “Select Company to Manage”, “Select Generator Type” filters, or enter a text string to search through all columns, if desired.
5.3.3.5 Viewing a Summary of Pending Review Interconnection Requests

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Pending Review from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Pending Review screen will be displayed.

You can use the “Display” filter or enter a text string to search through all columns, if desired.
5.3.3.6 Viewing a Summary of Submitted Interconnection Requests

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Submitted IRs from the IRTT menu on the left side of the IRTT Home screen or click on the orange colored “Submitted IRs” summary block.

Step #5: The IRTT Submitted IRs screen will be displayed.

You can use the “Select Company to Manage”, “Select Request Version” filters, or enter a text string to search through all columns, if desired.
5.3.3.7 **Viewing a Summary of Deficient Interconnection Requests**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See "Managing Access to Interconnection Requests" on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Deficient IRs from the IRTT menu on the left side of the IRTT Home screen or click on the red colored “Deficient IRs” summary block.

Step #5: The IRTT Deficient IRs screen will be displayed.
You can enter a text string to search through all columns, if desired.
5.3.3.8 Viewing a Summary of Valid Interconnection Requests

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Valid IRs from the IRTT menu on the left side of the IRTT Home screen or click on the green colored "Valid IRs" summary block.

Step #5: The IRTT Valid IRs screen will be displayed.

You can enter a text string to search through all columns, if desired.
5.3.3.9 **Viewing Associated Documents for an Interconnection Request**

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

---

**IMPORTANT!**

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.

---


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.
Step #2: Enter your E-mail address and Password and click “Sign In” to continue.

Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.
Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Draft IRs / Pending Review / Submitted IRs / Deficient IRs / Valid IRs (depending on the status of the desired Interconnection Request) from the IRTT menu on the left side of the IRTT Home screen.

Step #5: The IRTT Draft IRs / Pending Review / Submitted IRs / Deficient IRs / Valid IRs (depending on the status of the desired Interconnection Request) screen will be displayed. Click on “View Associated Documents” (file folder icon) at the right end of the record for the Interconnection Request you wish to view its associated documents.
Step #6: The IRTT Attachments screen will be displayed. You can click on “View” at the right end of the record for the associated document to view the contents of any file.

5.3.3.10 Exporting (PDF) an Interconnection Request

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

IMPORTANT!

- If you cannot find a specific Interconnection Request, you may not have access to that request.
- Please work with an individual at your company that has the IRTT Customer Admin role to be granted access to a request.
- See “Managing Access to Interconnection Requests” on page 78 for instructions on how this is managed.
- To learn who at your company is an IRTT Customer Admin, contact ISO New England’s IRTT Administrator via e-mail at IRTT@iso-ne.com.

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3: IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4: Once there are no submission issues, the IRTT Home screen will be displayed. Select Manage Requests->Draft IRs / Pending Review / Submitted IRs / Deficient IRs / Valid IRs (depending on the status of the desired Interconnection Request) from the IRTT menu on the left side of the IRTT Home screen.
Step #5: The IRTT Draft IRs / Pending Review / Submitted IRs / Deficient IRs / Valid IRs (depending on the status of the desired Interconnection Request) screen will be displayed. Click on “Export as PDF” (file icon) at the right end of the record for the Interconnection Request you wish to export.

Step #6: The IRTT Export IT Request screen will be displayed. The selected Interconnection Request will be presented in a basic report format. You can use the page functions to view the selected Interconnection Request.
NOTE: You can return to the IRTT Draft IRs / Pending Review / Submitted IRs / Deficient IRs / Valid IRs (depending on the status of the desired Interconnection Request) by clicking “Close” at the bottom of the screen.

Step #7: Click on “Export drop down menu” (computer disk icon) in the Export IR Request header. You can export the selected Interconnection Request to MS Excel, Adobe Reader (PDF), or MS Word by clicking on the corresponding option.
Step #8: The selected Interconnection Request will be opened in the selected format (MS Excel, Adobe Reader (PDF), or MS Word). You may either open the file or save the exported file.
5.3.4 Viewing the IR Dashboard

This section covers the following topics:

5.3.4.1 – Viewing the IR Dashboard (page 221)

5.3.4.1 Viewing the IR Dashboard

Role this applies to:

- IRTT Customer Admin
- IRTT IR Manager
- IRTT Viewer

Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Enter your E-mail address and Password and click “Sign In” to continue.
Step #3:  IRTT will validate the information submitted and notify you of any issues. You will be able to modify the submitted information to correct any noted issues.

Step #4:  Once there are no submission issues, the IRTT Home screen will be displayed. The IR Dashboard can be found in the center section of the IRTT Home screen.
5.3.5 Viewing the Public Queue

This section covers the following topics:

5.3.5.1 – Viewing the IRTT Public Queue (page 221)

5.3.5.1 Viewing the IRTT Public Queue


Select the ISO New England Interconnection Request Tracking Tool. This will open a window containing the IRTT Sign In screen.

Please see “Accessing IRTT via the ISO-NE Application Portal” on page 11 for more information.

Step #2: Select “View Public Requests Queue” in the Public Queue section.

NOTE: You can also access the Public Queue after sign in by selecting Reports->Public from the IRTT menu on the left side of the IRTT Home screen.
Step #3: The IRTT Public Queue screen will be displayed.

You can sort the presented list of requests by clicking the “˄˅” icons in each column header. Each column can be sorted in ascending or descending order.

You may filter the presented list of requests using two data elements:

- By Queue Status: This data element is a drop-down list of values that will allow you to limit the requests that currently have a specific Status value. The Status values are: All, Active, Commercial, and Withdrawn.

- By user-specified text: This data element (located next to the magnifying glass icon) allows you to enter a string that IRTT will use to search ALL columns in the Public Queue table and limit the requests accordingly. The filter is applied in real-time as the entry is made.

You can export the presented list of requests as an Excel file by clicking “Export to Excel”.

NOTE: You can return to the IRTT Sign In screen by clicking the ISO-New England IRTT System title in the screen’s header.
5.4 Communications

Event-driven e-mails are sent to the individual submitting the Interconnection Request and assigned to an Interconnection Request:

- The Primary Representative can be modified by clicking Settings->Manage Requests->IR Access/Contact from the IRTT menu on the left side of the IRTT Home screen. See the section titled “Managing the Primary Representative of an Interconnection Request” on page 82 for details on modifying the Primary Representative.
- The Primary Representative is the primary contact person for a project.

IRTT system-generated e-mails will come from the IRTTAdmin@iso-ne.com mail box. This mail box is not monitored. If you have questions about a particular message, please contact an ISO New England representative at IRTT@iso-ne.com.

Following are sample notifications generated by IRTT, including when:

- The ISO has successfully received a customer’s Interconnection Request.
- The ISO deems a request deficient. This notice acknowledges ISO-NE’s receipt of the request to the customer and provides deficiency details.
- The ISO determines a request to be valid.
Notice that the ISO has successfully received a customer’s Interconnection Request:

From: IRTT@iso-ne.com [mailto:IRTT@iso-ne.com]
To: admin@corp.com
Cc: IRTT@iso-ne.com
Subject: ISO New England has received your Large Generator Interconnection Request - 72464

ISO New England has received your Large Generator Interconnection Request.

Date & Time received: 24 January 2017 at 4:45 PM
Proposed Project: Large Project One
Reference Number: -72464

Request Type: Large
Interconnection Service Requested: Network Resource Interconnection Service (energy capability only)

For Process-Related Inquiries contact:
   Cheryl Ruehl- Manager, Transmission Services
   Telephone: (413) 540-4219
   E-mail: cruell@iso-ne.com

For Technical-Related Inquiries contact:
   Kevin Mankouksi- Manager, Transmission Service Studies
   (413) 535-4133
   E-mail: kmankouksi@iso-ne.com

Notice that the ISO has deemed a request deficient:

If a request is deficient, the comments provided in the e-mail will instruct customers on what was

---

**Your Interconnection Request has been deemed deficient for TCF-06279**

irrtINTNew@iso-ne.com

Sent: Mon 1/30/2017 1:26 PM
To: rttINTNew@iso-ne.com; IRTT Events; Cc: rttINTNew@iso-ne.com

---

Your Interconnection Request TCF-06279 has been deemed deficient.
IR Project Name: Test ETU IR

You may access and review the validation results by using the following link http://irrtintnew.iso-ne.com/deficient

The following comments were included with the deficiency validation:
This IR is Deficient.
Notice that the ISO has deemed a request valid:

<table>
<thead>
<tr>
<th>From:</th>
<th><a href="mailto:ittITNNew@iso-ne.com">ittITNNew@iso-ne.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td><a href="mailto:ittITNNew@iso-ne.com">ittITNNew@iso-ne.com</a></td>
</tr>
<tr>
<td>Subject:</td>
<td>Your Interconnection Request has been deemed valid for TCF-06279</td>
</tr>
</tbody>
</table>

Congratulations, your Interconnection Request **TCF-06279** has been deemed valid.

IR Project Name: **Test ETU IR - Version II**

You may access and review the validation results by using the following link [http://irttinfnew.iso-ne.com/valid](http://irttinfnew.iso-ne.com/valid)

The following comments were included with the validation:

This IR is Valid.
Section 6  IRTT Roles

6.1 IRTT Customer Admin

The IRTT Customer Admin role allows a customer to manage all aspects available to customers in IRTT. Available functions include the submitting an Interconnection Request, adding users, and managing specific access to a customer's Interconnection Requests.

Please see the following IRTT functions:

- “Get Started” (page 7)
- “Accessing IRTT” (page 9)
- “Maintaining IRTT Access” (page 36)
- “Managing Level of Access for a User Account” (page 72)
- “Managing Access to Interconnection Requests” (page 78)
- “Managing Interconnection Requests Overview” (page 94)
- “Submitting a new Large Generator Request” (page 95)
- “Submitting a new Small Generator Request” (page 115)
- “Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request” (page 130)
- “Viewing a Large Generator Request” (page 154)
- “Viewing a Small Generator Request” (page 164)
- “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179)

A company may have multiple users with the IRTT Customer Admin role. However, the first user registering a customer account must wait for their account to be verified before attempting to register additional users (regardless of the role assigned to those subsequent users).

The first account registered, as detailed in the section titled “Creating an IRTT Customer Admin Account (first IRTT account)” on page 16, is automatically granted the IRTT Customer Admin role.

Subsequent user accounts for a company are by default granted the IRTT Viewer role. Details of how to register additional accounts is detailed in the section titled “Creating an Additional IRTT Account (Admin setup)” on page 23 and “Confirming an Additional IRTT Account (Non-Admin setup)” on page 29.

A user with the IRTT Customer Admin role (typically the first user registering for a company) must explicitly grant the IR Customer Admin role to a user’s account. Instructions on modifying the access can be found in the section titled “Managing Level of Access for a User Account” on page 72.

6.2 IRTT IR Manager

The IRTT IR Manager role allows a customer to manage most of the functions available to customers in IRTT, except for user access. Available functions include managing specific access to a customer’s Interconnection Requests and the submission of an Interconnection Request and
subsequent review of submitted information (provided the user has been granted access to a specific Interconnection Request).

Please see the following IRTT functions:

- “Get Started” (page 7)
- “Accessing IRTT” (page 9)
- “Maintaining IRTT Access” (page 36)
- “Managing Level of Access for a User Account” (page 72)
- “Managing Access to Interconnection Requests” (page 78)
- “Managing Interconnection Requests Overview” (page 94)
- “Submitting a new Large Generator Request” (page 95)
- “Submitting a new Small Generator Request” (page 115)
- “Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request” (page 130)
- “Viewing a Large Generator Request” (page 154)
- “Viewing a Small Generator Request” (page 164)
- “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179)

A company may have multiple users with the IRTT IR Manager role.

The first account registered, as detailed in the section titled “Creating an IRTT Customer Admin Account (first IRTT account)” on page 16, is automatically granted the IRTT Customer Admin role which is inclusive of the IRTT IR Manager role.

Subsequent user accounts for a company are by default granted the IRTT Viewer role. Details of how to register additional accounts is detailed in the section titled “Creating an Additional IRTT Account (Admin setup)” on page 23 and “Confirming an Additional IRTT Account (Non-Admin setup)” on page 29.

A user with the IRTT Customer Admin role (typically the first user registering for a company) must explicitly grant the IR Manager role to a user’s account. Instructions on modifying the access can be found in the section titled “Managing Level of Access for a User Account” on page 72.

### 6.3 IRTT Viewer

The IRTT Viewer role allows a customer view access to IRTT.

Please see the following IRTT functions:

- “Get Started” (page 7)
- “Accessing IRTT” (page 9)
- “Maintaining IRTT Access” (page 36)
- “Viewing a Large Generator Request” (page 154)
- “Viewing a Small Generator Request” (page 164)
- “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179)
A company may have multiple users with the IRTT Viewer role.

Subsequent user accounts for a company are by default granted the IRTT Viewer role. Details of how to register additional accounts is detailed in the section titled “Creating an Additional IRTT Account (Admin setup)” on page 23 and “Confirming an Additional IRTT Account (Non-Admin setup)” on page 29.

A user with the IRTT Customer Admin role (typically the first user registering for a company) must explicitly grant the IR Manager role to a user’s account. Instructions on modifying the access can be found in the section titled “Managing Level of Access for a User Account” on page 72.
Section 7 Customer Support

7.1 By Internet

http://www.iso-ne.com/participate/support

7.2 By Telephone

During Regular Business Hours, Monday through Friday:

- 8:00 A.M. to 5:00 P.M. Eastern Time:
- (413) 540-4220

Days of Operation:

The Customer Support Hotline is NOT staffed on the following days:

- New Year's Day
- Martin Luther King Day
- Presidents Day
- Memorial Day
- Independence Day
- Labor Day
- Thanksgiving Day
- Day After Thanksgiving
- Christmas Eve Afternoon (12:00 to 17:30)
- Christmas Day
For emergency inquiries by pager:

- (877) 226-4814

7.3 By Email

**custserv@iso-ne.com**

7.4 Ask ISO

Ask ISO is available to market participants who have a valid digital certificate and who have been assigned the role of “Ask ISO / External User” by their Security Administrator. Ask ISO is located at [https://smd.iso-ne.com/](https://smd.iso-ne.com/).
Section 8 Links

8.1 ISO New England Home Page

http://www.iso-ne.com

8.2 ISO New England Training Page

http://www.iso-ne.com/participate/training

8.3 ISO New England FAQ Page

http://www.iso-ne.com/participate/support/faq

8.4 SMD Site for ISO Applications

https://smd.iso-ne.com/

8.5 SMD Site for ISO Sandbox Applications

https://sandboxsmd.iso-ne.com/

8.6 ISO New England Glossary and Acronyms

http://www.iso-ne.com/participate/support/glossary-acronyms
### Section 9 Reference Tables

#### 9.1 IRTT Roles and Permissions

<table>
<thead>
<tr>
<th>IRTT Role</th>
<th>Activities Allowed</th>
<th>Pertinent Sections in User Guide</th>
</tr>
</thead>
</table>
| IRTT Customer Admin      | The IRTT Customer Admin role allows a customer to manage all aspects available to customers in the IRTT. Available functions include the submitting an Interconnection Request, adding users, managing specific access to a customer's Interconnection Requests. | • “Get Started” (page 7)  
• “Accessing IRTT” (page 9)  
• “Managing Level of Access for a User Account” (page 72)  
• “Managing Access to Interconnection Requests” (page 78)  
• “Managing Interconnection Requests Overview” (page 94)  
• “Submitting a new Large Generator Request” (page 95)  
• “Submitting a new Small Generator Request” (page 115)  
• “Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request” (page 130)  
• “Viewing a Large Generator Request” (page 154)  
• “Viewing a Small Generator Request” (page 164)  
• “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179) |
| IRTT IR Manager          | The IRTT IR Manager role allows a customer to manage most of the functions available to customers in the IRTT, except for user access. Available functions include managing specific access to a customer's Interconnection Requests. | • “Get Started” (page 7)  
• “Accessing IRTT” (page 9)  
• “Managing Level of Access for a User Account” (page 72) |
| Interconnection Requests and the submission of an Interconnection Request and subsequent review of submitted information (provided the user has been granted access to a specific Interconnection Request). | • “Managing Access to Interconnection Requests” (page 78)  
• “Managing Interconnection Requests Overview” (page 94)  
• “Submitting a new Large Generator Request” (page 95)  
• “Submitting a new Small Generator Request” (page 115)  
• “Submitting a new Elective Transmission Upgrade (ETU) Interconnection Request” (page 130)  
• “Viewing a Large Generator Request” (page 154)  
• “Viewing a Small Generator Request” (page 164)  
• “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179) |
|---|---|
| IRTT Viewer | The IRTT Viewer role allows a customer view access to IRTT. | • “Get Started” (page 7)  
• “Accessing IRTT” (page 9)  
• “Maintaining IRTT Access” (page 36)  
• “Viewing a Large Generator Request” (page 154)  
• “Viewing a Small Generator Request” (page 164)  
• “Viewing an Elective Transmission Upgrade (ETU) Interconnection Request” (page 179) |

### 9.2 IRTT System Requirements

HTML-5-based browsers such as Firefox, Chrome, and Safari should function with the application; however, only Internet Explorer is supported. Please refer to the Web Browser Support for SMD Applications section of our website which can be found under Participate > Support > Web Browser Support for information on the browsers and security protocols ISO New England supports.
The ISO New England Application Portal requires the Java Runtime Environment (JRE), version 1.5 (or higher).

Users will be prompted to install the Unified Access Gateway Plug-in or Java Applet the first time they visit the ISO New England Application Portal.

Please work with your company's desktop or IT support first to ensure the minimum requirements have been met. If additional support is needed, please contact ISO New England's Customer Support. See page 229 for the contact information.